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1 DESCRIPTION 

1.1 Description 

Contained in this document are details concerning the algorithm for creating Level 4 (L4) spatially 

rectified watershed hydrology data of NEON aquatic field sites using ArcGIS Pro 2.4.0. Specifically, the 

process for converting elevation data into delineated watersheds.  

1.2 Purpose 

This document details the algorithms used for creating NEON Level 4 spatially rectified watershed 

hydrology boundaries from Level 3 data. It includes a detailed discussion of measurement theory and 

implementation, appropriate theoretical background, data product provenance, quality assurance and 

control methods used, approximations and/or assumptions made, and a detailed exposition of 

uncertainty resulting in a cumulative reported uncertainty for this product.  

1.3 Scope 

This document describes the theoretical background and entire algorithmic process for deriving 

watershed boundaries from input data.  It does not provide computational implementation details, 

except for cases where these stem directly from algorithmic choices explained here.   
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2 RELATED DOCUMENTS, ACRONYMS, AND VARIABLE NOMENCLATURE 

2.1 Applicable Documents 

AD[01] NEON.DOC.000001         NEON Observatory Design (NOD) Requirements 

AD[02] NEON.DOC.002652         NEON Level 1-3 Data Products Catalog 

AD[03] NEON.DOC.005005         NEON Level 0 Data Products Catalog 

AD[04] NEON.DOC.002390         NEON Algorithm Theoretical Basis Document (ATBD): NEON 

Elevation (DTM and DSM) 

AD[05] NEON.DOC.001984         AOP Flight Plan Boundaries Design  

AD[06] NEON.DOC.003601-3618 Aquatic Site Sampling Design – NEON Domain 01-19 

2.2 Reference Documents 

RD[01] NEON.DOC.000008         NEON Acronym List 

RD[02} NEON.DOC.000243         NEON Glossary of Terms 

RD[03] NEON.DOC.0005011       NEON Coordinate Specification 

RD[04] NEON.DOC.001292         NEON L0-to-L1 Discrete Return LiDAR Algorithm Theoretical Basis 

Document (ATBD) 

RD[05] NEON.DOC.002293          NEON Discrete LiDAR Datum Reconciliation Report 

2.3 External References 

ER[01] Dean B. Gesch et al., “The National Elevation Dataset” (American Society for 

Photogrammetry and Remote Sensing, 2018). 

https://pubs.er.usgs.gov/publication/70201572 

ER[02] Dean B. Gesch et al., “Accuracy Assessment of the U.S. Geological Survey National 

Elevation Dataset, and Comparison with Other Large-Area Elevation Datasets: SRTM and 

ASTER,” USGS Numbered Series, Open-File Report (Reston, VA: U.S. Geological Survey, 

2014). http://pubs.er.usgs.gov/publication/ofr20141008 

ER[03] (Toolset) Arc Hydro Installation - Versions and Documentation, GeoNet, The Esri 

Community. Tutorial Version 2.0, October 2011, Arc Hydro Version ArcHydroPro2.0.43, 

September 2019. https://community.esri.com/message/393615-arc-hydro-installation-

versions-and-documentation 

ER[04] (Dataset) U.S. Geological Survey, National Geospatial Program, The National Map, 3D 

Elevation Program, Elevation Products, 1/3 arc-second DEM, TNM Download. 

https://viewer.nationalmap.gov/basic/ 

ER[05] (Dataset) Multi-Resolution Land Characteristics Consortium (MRLC 2018), National Land 

Cover Database (NLCD 2011). https://data.nal.usda.gov/dataset/national-land-cover-

database-2011-nlcd-2011 

https://pubs.er.usgs.gov/publication/70201572
http://pubs.er.usgs.gov/publication/ofr20141008
https://community.esri.com/message/393615-arc-hydro-installation-versions-and-documentation
https://community.esri.com/message/393615-arc-hydro-installation-versions-and-documentation
https://viewer.nationalmap.gov/basic/
https://data.nal.usda.gov/dataset/national-land-cover-database-2011-nlcd-2011
https://data.nal.usda.gov/dataset/national-land-cover-database-2011-nlcd-2011
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ER[06] (Dataset) U.S. Department of Agriculture, Natural Resources Conservation Service, Web 

Soil Survey Gridded Soil Survey Geographic (SSURGO) Database.  

https://websoilsurvey.nrcs.usda.gov/ 

ER[07] (Software) ESRI 2019. ArcGIS Pro: Release 2.4. Redlands, CA: Environmental Systems 

Research Institute. https://www.esri.com/en-us/arcgis/products/arcgis-pro/overview 

ER[08] Goulden, T., C. Hopkinson, R. Jamieson, and S. Sterling. 2014. “Sensitivity of Watershed 

Attributes to Spatial Resolution and Interpolation Method of LiDAR DEMs in Three Distinct 

Landscapes.” Water Resources Research 50 (3): 1908–27. 

https://doi.org/10.1002/2013WR013846 

ER[09] Amatya, Devendra, Carl Trettin, Sudhanshu Panda, and Herbert Ssegane. 2013. 

“Application of LiDAR Data for Hydrologic Assessments of Low-Gradient Coastal Watershed 

Drainage Characteristics.” Journal of Geographic Information System. 5(2): 175-191 5 (2): 

175–91. https://doi.org/10.4236/jgis.2013.52017 

ER[10] Chow, T. Edwin, and Michael E. Hodgson. 2009. “Effects of Lidar Post‐spacing and DEM 

Resolution to Mean Slope Estimation.” International Journal of Geographical Information 

Science 23 (10): 1277–95. https://doi.org/10.1080/13658810802344127 

ER[11] Goulden, T. and C. Hopkinson. 2010. “The forward propagation of integrated system 

component errors within airborne lidar data.” Photogrammetric Engineering and Remote 

Sensing. 76(5), 589‐601. https://doi.org/10.14358/PERS.76.5.589 

ER[12] U.S. Geological Survey and U.S. Department of Agriculture, Natural Resources Conservation 
Service, 2013, “Federal Standards and Procedures for the National Watershed Boundary 
Dataset (WBD)” (4 ed.): Techniques and Methods 11–A3. https://pubs.usgs.gov/tm/11/a3/ 

ER[13] (Dataset) U.S. Department of Agriculture, Natural Resources Conservation Service, U.S.  
General Soil Map, State Soil Geographic Database (STATSGO2).   
https://websoilsurvey.nrcs.usda.gov/ 

2.4 Acronyms 

Acronym Explanation 

AIS Aquatic Instrument System 

AOP Airborne Observation Platform 

AOS Aquatic Observation System 
ATBD Algorithm Theoretical Basis Document 

DEM Digital Elevation Model 

DP Data Product 

DTM Digital Terrain Model 

GNIS Geographic Names Information System 

L3 Level 3 

L4 Level 4 

LiDAR Light Detection and Ranging 

MRLC Multi-Resolution Land Characteristics Consortium 

NCSS National Cooperative Soil Survey 

https://websoilsurvey.nrcs.usda.gov/
https://www.esri.com/en-us/arcgis/products/arcgis-pro/overview
https://doi.org/10.1002/2013WR013846
https://doi.org/10.4236/jgis.2013.52017
https://doi.org/10.1080/13658810802344127
https://doi.org/10.14358/PERS.76.5.589
https://pubs.usgs.gov/tm/11/a3/
https://websoilsurvey.nrcs.usda.gov/
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NED National Elevation Dataset 

NLCD National Land Cover Database 

NRCS Natural Resources Conservation Service 

NSSDA National Standard for Spatial Data Accuracy 

QA/QC Quality assurance and quality control 

SSURGO Soil Survey Geographic database 

TNM The National Map 

USDA United States Department of Agriculture 

USGS United States Geological Survey 

UTM Universal Transverse Mercator 

WGS84 World Geodetic System 1984 

2.5 Variables 

2.5.1 Watershed Delineation 

Table 1. Watershed Variables 

File File Type Process Variable Description 

elevation.tif raster Input DEM 10 meter DEM elevation raster 
file(s) downloaded from USGS 
TNM Download. 

DTM.tif  raster Input DTM 1 meter DTM elevation raster 
file(s) downloaded from NEON 
Data Portal. 

Fil raster  raster Output Fill Elevation manipulation to fill 
errors (low points (e.g. sinks)) in 
the raster data  

Fac raster  raster Output Flow Accumulation Weighted value raster of cells 
flowing into each down slope 
cell. 

Fdr raster  raster Output Flow Direction Value raster of cell direction 
flowing from steepest to 
downslope neighbor. 

Cat raster  raster Output Catchment Area of contributing cells above 
a reference point/cell. 

Strlnk raster  raster Output Stream Link Raster grid of unique stream 
segments defined as either head 
segments (the most upstream 
stream branch), or segments 
located between two segment 
junctions. 

Str raster  raster Output Stream Raster of streams defined by a 
threshold drainage area. 
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Catchment.shp  shapefile Output Catchment Polygon shapefile that defines 
zones of cells whose drainage 
flows through each stream link.  

AdjointCatchment.shp  shapefile Output Adjoint Catchment Polygon shapefile of aggregated 
upstream catchments. 

DrainageLine.shp  shapefile Output Drainage Line Line shapefile of drainage 
system derived from the stream 
link grid. 

DrainagePoint.shp  shapefile Output Drainage Point Point shapefile of drainage at 
the most downstream point in 
the catchments.  

PourPoint.shp  shapefile Output Pour Point Output point shapefile of the 
lowest point along the boundary 
of the local watershed. 

Watershed.shp  shapefile Output Watershed Polygon shapefile of the total 
area flowing to the pour point. 

WatershedPoint.shp  shapefile Output Watershed Point Point shapefile of the point at 
which water flows out of an 
area. 

2.5.2 Land Use 

Table 2. NLCD Land Use Classification 

Watershed Attribute Table Abbreviation Classification Description Classification Number 

NLCD_11 Open Water 11 

NLCD_12 Perennial Ice/Snow 12 

NLCD_21 Developed, Open Space 21 

NLCD_22 Developed, Low Intensity 22 

NLCD_23 Developed, Medium Intensity 23 

NLCD_24 Developed, High Intensity 24 

NLCD_31 Barren Land (Rock/Sand/Clay) 31 

NLCD_41 Deciduous Forest 41 

NLCD_42 Evergreen Forest 42 

NLCD_43 Mixed Forest 43 

NLCD_51 Dwarf Scrub 51 

NLCD_52 Shrub/Scrub 52 

NLCD_71 Grassland/Herbaceous 71 

NLCD_72 Sedge/Herbaceous 72 

NLCD_74 Moss 74 

NLCD_81 Pasture/Hay 81 

NLCD_82 Cultivated Crops 82 

NLCD_90 Woody Wetlands 90 



 

Title:  NEON Algorithm Theoretical Basis Document (ATBD): Watershed Delineation  Date:  05/26/20222 

NEON Doc. #:  NEON.DOC.005246 Author:  M. Slater and V. Waits Revision:  C 

 

Page 6 of 19 

NLCD_95 Emergent Herbaceous Wetlands 95 

NLCDNoData NA NA 

2.5.3 Soil 

Table 3. NRCS Soil Taxonomy Order Classification 

Watershed Attribute Table Abbreviation Soil Classification Orders Soil Classification 

Abbreviation 

NRCS_ALF Alfisols ALF 

NRCS_ARI Aridisols ARI 

NRCS_AND Andisols AND 

NRCS_ENT Entisols ENT 

NRCS_GEL Gelisols GEL 

NRCS_HIS Histosols HIS 

NRCS_INC Inceptisols INC 

NRCS_MOL Mollisols MOL 

NRCS_OXI Oxisols OXI 

NRCS_SPO Spodosols SPO 

NRCS_ULT Ultisols ULT 

NRCS_VER Vertisols VER 

NRCS_WATER NA (Water) NA 

NoSoilData NA NA 

2.5.4 Variables Reported 

Table 4. Watershed Output Variables Reported 

Watershed Attribute 

Table Name 

Description of Attribute 

DATA States if the watershed was not derived from NEON data, these sites are 

supplemented with the 10 meter National Elevation Dataset. 

Area_NED Watershed area in kilometers squared for sites where the watershed was 

derived from the 10 meter National Elevation Dataset. 

WSAreaKm2 Watershed area in kilometers squared for watersheds derived from NEON’s 1 

meter Elevation-LiDAR dataset. 

DomainNum NEON ecoclimatic domain number.  

DomainName NEON ecoclimatic domain name. 

SiteName NEON aquatic site name. 

SiteID NEON four character site ID for the aquatic site. 

SiteType Type of NEON site (e.g. core aquatic or gradient aquatic). 
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Science Identifies the primary science theme as they relate to the NEON Grand 

Challenges (AD[01]) and if the aquatic site is a wadeable or non-wadeable 

stream, or lake. 

StateID The 2 letter abbreviation for the state where the watershed is located. 

HUC12Name Name of the Hydrologic Unit Code with twelve digits based on the prominent 

water or physical feature(s) within the unit. Naming follows the conventions 

and rules outlined by the Geographic Names Information System (GNIS) order 

of priority and if the dominant feature is named in the HU10, the HU12 

retains the twelve digit code as the name (ER[12]).  

HUC12 Hydrologic Unit Code with twelve digits based on the sixth-level 

(subwatershed) classification designated by the United States Geological 

Survey (ER[12]).  

TIS_Dist Distance in kilometers from the aquatic site pour point to the corresponding 

terrestrial tower site. 

TIS_Bear Bearing in degrees from the aquatic site pour point to the corresponding 

terrestrial tower site. 

TIS_WS States if the corresponding terrestrial tower is within the aquatic watershed. 

AOPLiDAR Name of the Elevation-LiDAR DTM tile from the NEON data portal, includes 

site ID, year, and month the data was collected. 

AOP_Flight Identifies the NEON AOP Flight Boundaries layer showing the extent and 

priority of airborne acquisition.   

AOPCoverag Identifies the percent coverage of the NEON AOP flight box over the aquatic 

watershed. 

UTM_Zone The local projected coordinate system for the aquatic site and model 

processing. 

NLCD_(number) Percentage of land cover classifications within the watershed from the 

National Land Cover Dataset (NLCD) (Table 2).  

NRCS_(Soil 

abbreviations) 

Percentage of soil classifications within the watershed from the Natural 

Resources Conservation Service (NRCS) (Table 3). 
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3 DATA DESCRIPTION 

Watershed delineation incorporates multiple input and output files to derive an area of land that 

captures surface drainage, land use, and soil characteristics impacting Aquatic Instrumentation Systems 

(AIS) and Aquatic Observation Sampling (AOS) at NEON aquatic field sites.  

3.1 Input Dependencies 

3.1.1 Elevation Data   

Table 5. Elevation Model 

Input File type Description 
1m DTM raster 1 meter resolution Digital Terrain Model (DTM) produced by NEON 

Elevation-LiDAR data product (DP) AD[02] 

10m DEM raster 10 meter resolution Digital Elevation Model (DEM) provided by USGS 
National Elevation Dataset (NED) ER[04] 

3.1.2 AIS Sensor Locations 

Table 6. AIS Sensor 

Input File type Description 

Outlet Sensor shapefile In-situ sensor located at lake outlet 

S1 Sensor shapefile In-situ sensor location used for non-wadeable streams 

S2 Sensor shapefile In-situ sensor location used for wadeable streams 

3.1.3 Land Use Data   

Table 7. NLCD Land Use Classification 

Input File type Description 

NLCD  shapefile 2016 National Land Cover Database (NLCD) ER[05] 

3.1.4 Soil Map Units 

Table 8. NRCS Soil Classification 

Input File type Description 
SSURGO shapefile  Soil Survey Geographic Database (SSURGO) ER[06] 
STATSGO2 shapefile State Soil Geographic Database (STATSGO) ER[13] 

3.2 Product Instances 

One watershed was delineated for each of the 34 NEON aquatic sites. Watershed shapefiles and maps 

are provided on neonscience.org and neon.maps.arcgis.com.  
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3.3 Temporal Resolution and Extent 

LiDAR data gathered from NEON’s Airborne Observation Platform (AOP) were used to derive 1 meter 

resolution watersheds. LiDAR data from these flights were collected during the >90% peak greenness of 

dominant vegetation at each site between 2016-2019 (AD[05]).   

DEM data provided by the USGS National Elevation Dataset (NED) (ER[01]) were used to derive 10 meter 

resolution watersheds. Data acquisition for the NED range from 2013 to 2019 (ER[04]).  

As additional LiDAR data become available from future airborne observation flight campaigns, the LiDAR 

derived watersheds may be updated and revised.   

3.4 Spatial Resolution and Extent 

Watersheds derived from 1 meter resolution DTM provided by NEON range in size from 0.57 km2 to 

120.40 KM2. For a small portion of the aquatic sites, NEON’s AOP Elevation - LiDAR data product 

(DP3.30024.001) did not cover the entire aquatic watershed (AD[05]). Where NEON LiDAR data did not 

provide complete watershed coverage, the 10 meter DEM was used to model the watershed. 

Watersheds derived from 10 meter resolution DEM provided by USGS NED range in size from 6.34 KM2 

to 47085.35 KM2. Each of the 34 aquatic sites have one final, complete watershed produced with either 

the LiDAR DTM or the National DEM.  
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4 SCIENTIFIC CONTEXT 

Hydrological drivers, weather, climate, biogeochemistry, and seasonal biological transitions are 

important drivers and indicators of aquatic ecosystem function. At each aquatic field site, the NEON 

project collects data to understand changes in climate, hydrology,  biogeochemical processes, organismal 

populations, and habitat structure. Hydrology models reveal how water flows across surface areas. 

Watershed delineation, based on high-resolution elevation models, produce lower stream network and 

stream density error estimates. This results in higher spatial accuracy when modeling across low-

gradient to moderately sloping terrain (ER[08], ER[09], ER[10]). When paired with other NEON 

meteorological, surface, and subsurface hydrologic data, these watershed layers can aid in 

understanding hydrologic processes at the watershed scale. In conjunction with looking at the dynamics 

of water flow, the land use application and soil classification serves as a further indicator suggesting the 

type of ecological environment and influences the lakes or stream of interest may currently possess. 

This information is valuable when trying to interpret chemical characteristics and the types of aquatic 

biota in the lake or stream without having to travel to the area.  

4.1 Theory of Measurement 

Digital elevation models provide a 3-dimensional representation of a surface terrain and contain values 

that are horizontally and vertically referenced to a gridded coordinate system based on a  datum, geoid 

(or spheroid) model, and a local projection. NEON utilizes the World Geodetic System 1984 (WGS84) 

datum, and a local Universal Transverse Mercator (UTM) projection for horizontal reference, and 

Geoid12A for high-accuracy vertical reference (RD[03]).  External data not utilizing the identified datum 

were converted to WGS84 and re-projected into a local UTM surface projection. For details on NEON’s 

Basic LiDAR Theory for Airborne Laser Mapping see RD[04].  

4.2 Theory of Algorithm 

This workflow serves the purpose to provide high-resolution watershed boundaries for NEON’s aquatic 

field sites. The Elevation – LiDAR (DP3.30024.001) Level 3 (L3) data product (AD[02]) required to 

complete the L4 data transformation is a 1 meter resolution Digital Terrain Model (DTM) raster  and 

serves as the high-resolution elevation model from which the watersheds were derived. The DTM can be 

downloaded from the NEON website data portal https://data.neonscience.org/home. In cases where 

NEON data did not provide a complete watershed (AD[05]), a 1/3 arc-second (10 meter) resolution 

Digital Elevation Model (DEM) raster, available from the U.S. Geological Survey (USGS) website (ER[04]), 

was utilized to provide full coverage of the watershed extent. A mosaic dataset was created to combine 

individual DTM or DEM tiles, and a local projection defined for the dataset. ArcGIS Pro software with the 

ArcHydro Tools [for] Pro were used to model and delineate the watershed (ER[03], ER[07]).  

A depressionless DEM created from the input mosaic removes erroneous data errors in the DEM 

creating a smooth elevation surface. By identifying low elevation cells surrounded by higher elevation 

cells and manipulating the elevation value to eliminate low points (sinks) in the grid, the adjusted DEM is 

https://data.neonscience.org/home
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then run through the Basic Dendritic Terrain Processing model to produce drainage basin rasters, 

catchment areas, and drainage lines. 

 

Figure 1. Basic Dendritic Terrain Processing Model 

The Basic Dendritic Terrain Processing model is comprised of 9 tools [Figure 1].  

• Flow Direction generates a raster that identifies the direction of water flow across the landscape 

based on the direction of the steepest descent in each cell.  

• Flow Accumulation generates a weighted raster of cells where the cumulative count of pixels 

along the defined flow direction is identified for every cell. Areas of high accumulation represent 

the drainage basin and areas of no accumulation (e.g. zero) represent the watershed boundary. 

• Stream Definition is defined through a default threshold of 1% of the maximum flow 

accumulation. Cells with accumulation greater than 1% are classified as stream cells and all 

other cells are classified as land surface draining into those streams.  

• Stream Segmentation generates a raster grid of unique stream links at every confluence by 

connecting head segments (the most upstream stream branch) and an outlet, or a junction and 

the drainage divide. 

• Drainage Line Processing converts the stream link grid into a Drainage Line feature class. Each 

line in the feature class carries a unique identifier of the catchment in which it resides and how 

it connects to its downstream features. In cases where a line has more than one downstream 

feature, a Drainage Line Flow Split Table identifies the other, secondary downstream feature(s).    

• Catchment Grid Delineation generates the Catchment raster in which each cell carries a value 

(grid code) indicating to which catchment the cell belongs. The value corresponds to the value of 

the stream link defined during Stream Segmentation. 
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• Catchment Polygon Processing converts the Catchment raster into a polygon area feature class.  

• Adjoint Catchment Processing generates an Adjoint Catchment polygon feature class 

representing the aggregated area upstream from the head catchment (identified during the 

Catchment Grid Delineation) that drains into the inlet point of the Catchment feature class. In 

cases where a catchment has more than one downstream feature, as identified in the Drainage 

Line Flow Split Table, an Adjoint Catchment Flow Split Table with a corresponding value is 

generated to identify the other downstream catchment(s).  

• Drainage Point Processing creates a drainage point at the downstream most point in the 

catchment. 

A pour point, representing the downstream most sensor set in the NEON AIS reach, is used to create a 

local outlet representing the lowest point along the boundary of the local watershed. This is primarily 

the location of the S2 sensor set in wadeable streams, the S1 sensor set in non-wadeable rivers, and the 

outlet sensor set in lakes.  

 

Figure 2. Watershed Delineation Model 

 

The Watershed Delineation script (Figure 2) is run with the Flow Direction, Stream, Catchment, and 

Adjoint Catchment outputs produced from the Basic Dendritic Terrain Processing model to create a 

polygon area upstream of the defined NEON pour point. The local watershed created from this workflow 

represents the area of influence where surface water collects and drains into a NEON aquatic field site. 

A Watershed Point feature class (related to the NEON pour point) is generated with the HydroID of the 

corresponding Watershed.  

Ancillary data within the watershed include thematic land use data classifications from the 2016 (CONUS 

and AK), and 2001 (PR) National Land Cover Database (NLCD), provided by the Multi-Resolution Land 

Characteristics (MRLC) Consortium (ER[05]). Soil map unit classifications provided from the Soil Survey 
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Geographic (SSURGO) database (ER[06]), (available for most sites), and the U.S. General Soil Map 

(STATSGO) (ER[13]) database (for FLNT, BLWA, TOMB, SYCA, TOOK, OKSR) were collected by the 

National Cooperative Soil Survey (NCSS), and distributed by the United States Department of Agriculture 

(USDA), Natural Resources Conservation Service (NRCS). These ancillary data help to identify potential 

chemical characteristics and provide a general understanding of the surface hydrology and nearby 

characteristics affecting an aquatic site.  

4.3 Special Considerations 

There are 11 aquatic sites where NEON’s AOP LiDAR did not provide a complete watershed. In these 

cases a 10 meter National DEM was used to derive the watershed. For 5 of these sites, the watersheds 

are too large for AOP to complete coverage with the current Operations model. These sites include, D03 

Flint River (FLNT), D08 Lower Tombigbee River (TOMB), D10 Arikaree River (ARIK), D11 Blue River 

(BLUE), and D14 Sycamore Creek (SYCA). Plans are being made for the remaining sites to adjust flight 

lines and capture the entire extent of the aquatic watershed. In the case of Black Warrior River (BLWA) 

where AOP coverage is available for the watershed extent, processing errors (possibly due to LiDAR 

reflectance either reflecting weakly, or being absorbed from water surfaces) generated a high-resolution 

elevation tile with large gaps in the data. The workflow for this site may be adjust or re-examined to 

address this issue in the future.  
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5 ALGORITHM IMPLEMENTATION 

Provided is a sequential guide to transform an L3 Data Product into L4 Data for watershed delineation. 

The land use data and the soils data are secondary applications to show the benefits of overlaying the 

land use and soils data inside the watershed for additional interpretation. 

5.1 Required Platforms, Tools and Inputs 

1) ArcGIS Pro 2.4x (ER[07]) 

a) Data Management Tools toolbox 

i) Raster tools > Create Raster Dataset 

ii) Raster tools > Add Rasters to Mosaic Dataset 

iii) Feature Class tools > Create Feature Class 

b) Conversion Tools toolbox 

i) To Geodatabase tools > Feature Class to Feature Class 

c) ArcHydro Tools Pro 2.0.47 or later (ER[03]) 

i) Terrain Preprocessing toolbox 

(1) DEM Manipulation Tools > Fill Sink 

ii) Terrain Preprocessing Workflows toolbox 

(1) Dendritic tools > Basic Dendritic Terrain Processing 

(2) Watershed Processing tools > Watershed Delineation 

2) Elevation Model 

a) Digital Terrain Model 

i) DTM.tif(s) tiles downloaded from the NEON Data Portal, Elevation - LiDAR data product 

(AD[02]) 

b) Digital Elevation Model 

i) DEM.tif(s) downloaded from the USGS National Map Data Download Service (ER[04]) 

3) NEON AIS Sensors (AD[06])  

a)  S2 sensor set in wadeable streams, the S1 sensor set in non-wadeable rivers, and the outlet 

sensor set in lakes 

5.2 Data Processing 

Italicized text indicates action 

Bold text indicates expression 

[Encapsulated] text indicates result 
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5.2.1 Mosaic 

DTM tiles provided by NEON or DEM tiles provided by USGS added to a mosaic dataset and projected in the local 

UTM zone. 

1. Open ArcPro 2.4.0 or later 
a. Create new project  

i. New > Map > Create a New Project > Create Name and output Location > Check 
box for Create a new folder for this project 

2. Create Mosaic Dataset 

a. View Tab > Catalog View > Navigate to project folder, then to geodatabase > Right click 

geodatabase > New > Mosaic Dataset  

i. Output Location: Navigate to work folder File Geodatabase path  

ii. Mosaic Dataset Name: “Site_LiDAR” or “Site_NED”  

iii. Coordinate System: Projected Coordinate System 

1.  UTM > WGS 1984 > Northern Hemisphere > WGS 1984 UTM Zone xN 

iv. Product Definition: None 

v. Product Properties: Default 

vi. Pixel Properties: Default 

vii. Run 

b. Result: [Empty Site Mosaic Dataset] 

3. Add Rasters To Mosaic Dataset 

a. Data Management Tools > Raster > Mosaic Dataset> Add Rasters to Mosaic Dataset tool 

i. Select Mosaic Dataset created in 5.2.1.2 

ii. Raster Type: Raster Dataset 

iii. Processing Templates: Default 

iv. Input Data: Dataset 

v. Browse: Add Elevation (DTM/DEM) .tif files 

vi. Advanced Input Data Options: Default 

vii. Raster Processing:  

1. Check box for Calculate Statistics  

2. Check box to Build Raster Pyramids 

3. Maximum Levels: Default 

4. Maximum Cell Size: Default 

viii. Mosaic Post-processing: Default 

b. Result: [Mosaic Dataset of DTM or DEM tiles] 

5.2.2 Watershed Delineation 

1. Fill Sinks 

a. Arc Hyrdo Tools Pro Toolbox > Terrain Preprocessing > DEM Manipulation > Fill Sinks 

i. Input DEM Raster:  Site_LiDAR or Site_NED 
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ii. Output Hydro DEM Raster: Navigate to work folder, rename: Fil 

iii.  Fill Threshold (optional): Leave blank 

iv. Input Deranged Polygon Feature Class (optional): Leave blank 

v. Use IsSink Field box: Leave unchecked 

b. Result: [Fil raster]  

2. Basic Dendritic Terrain Processing 

a. Arc Hydro Tools Pro Toolbox > Terrain Preprocessing Workflows > Dendritic > Basic Dendritic 

Terrain Processing 

i. Input Hydro DEM raster: Fil (created in 5.2.2.1) 

ii. Output Drainage Line Feature Class: Navigate to work folder: DrainageLine 

iii. Output Drainage Line Flow Split Table: Navigate to work folder: DrainageLine_FS 

iv. Output Catchment Feature Class: Navigate to work folder: Catchment 

v. Output Adjoint Catchment Feature Class: Navigate to work folder: 

AdjointCatchment 

vi. Output Catchment Flow Split Table: Navigate to work folder: Catchment_FS 

vii. Output Drainage Point Feature Class: Navigate to work folder: DrainagePoint 

viii. Output Flow Accumulation Raster: Navigate to work folder: fac 

ix. Output Flow Direction Raster: Navigate to work folder: fdr 

x. Output Catchment Raster: Navigate to work folder: cat 

xi. Output Stream Link Raster: Navigate to work folder: StrLnk 

xii. Output Stream Raster: Navigate to work folder: str 

b. Result: [DrainageLine, DrainageLine_FS, Catchment, AdjointCatchment, Catchment_FS, 

DrainagePoint, fac Raster, fdr Raster, cat Raster, StrLnk Raster, str Raster] 

 

5.2.3 Pour Point 

Generate a point using the downstream most AIS sensor set, primarily NEON’s S2 sensor in wadeable streams, S1 

in non-wadeable rivers, and the outlet sensor in lakes.   

1. Create Feature Class 

a. Data Management Tools Toolbox > Feature Class > Create Feature Class 

i. Feature Class Location: Navigate to Work Folder 

ii. Feature Class Name: PourPoint 

iii. Select Geometry Type: Point 

iv. Template Feature Class: Leave blank 

v. Has M: No 

vi. Has Z: No 

vii. Feature Class Alias (optional): Leave blank 

viii. Environments, Output Coordinate System: UTM xx 

b. Result: [Empty PourPoint.shp] 

2. Create Pour Point Geometry 
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a. Edit Tab > Create Features Ribbon 

i. Create Features Templates: PourPoint 

1. Create a pour point on the drainage line nearest the applicable AIS 

sensor set with left mouse click 

2. Manage Edits Ribbon > Save 

ii. Result: [PourPoint.shp] 

 

5.2.4 Create Watershed 

Generate local watershed using inputs from the Basic Dendritic Terrain Processing model and Pour Point.  

1. Watershed Delineation 

a. Arc Hyrdo Tools Pro Toolbox > Watershed Processing > Watershed Delineation 

i. Input Batch Point Feature Class: PourPoint (created in 5.2.3) 

ii. Input Snap Distance: 1 

iii. Input flow direction raster: fdr 

iv. Input Stream Raster: str 

v. Input Snap Stream Raster: str 

vi. Input Catchment Feature Class: Catchment 

vii. Input Adjoint Catchment Feature Class: AdjointCatchment 

viii. Input Sink Point Raster: Leave blank 

ix. Input Sink Watershed Feature Class: Leave blank 

b. Result: [Watershed.shp] 

c. Result: [WatershedPoint] 
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6 UNCERTAINTY 

6.1 Elevation Uncertainty 

Watershed delineation was performed at two different spatial scales; the 10 meter resolution (1/3 arc-

second) National Elevation Dataset DEM, and the 1 meter resolution. 

The 2014 accuracy assessment report from the USGS identifies the absolute vertical uncertainty within 

the National Elevation Dataset (NED) with a root mean square error of 3.04 meters for the conterminous 

United States expressed to the 95 percent confidence level in accordance with the National Standard for 

Spatial Data Accuracy (NSSDA). The accuracy assessment for the 1/3 arc-second NED utilized over 

25,000 North America National Geodetic Survey (NGS) benchmarks with millimeter to centimeter-level 

accuracy (Geoid12A). Root mean square error statistics were produced after bilinear interpolation of the 

NGS control points and calculated from the residual error of the geodetic control measured against the 

NED (ER[02]).  

Analysis of uncertainty in the NEON Elevation - LiDAR data product is described in AD[04]. Simulated 

vertical uncertainty associated with each grid cell is reported in a separate raster of uncertainty values 

as part of the “L3 discrete lidar processing and QA information” packaged with each data product from 

each site. Simulated uncertainty is obtained from the system errors propagated through to the point 

cloud, as discussed in RD[04], and then propagated further into the DTM / DSM. Error simulations follow 

the algorithm described in ER[08] and ER[11], and implement the uncertainty values for each subsystem. 

Uncertainty in the trajectory can be seen in the associated SBET QAQC document associated with the 

flight day(s). The range uncertainty is determined from yearly calibration flights at the Boulder airport. 

Simulated uncertainty is based solely on the instrument sub‐systems and does not take into account 

uncertainty introduced by external surface features or vegetation. 

6.2 Model Uncertainty 

Within the Basic Dendritic Terrain Processing model, Stream Definition is defined through the use of a 

default threshold drainage area of 1% of the maximum flow accumulation.  Cells in the input flow 

accumulation grid that have a value greater than the threshold are indicative of the minimum number of 

cells that characterize a surface drainage. A smaller threshold would result in a denser drainage network 

(ER[03]). 
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7 FUTURE PLANS AND MODIFICATIONS 

As additional NEON Elevation - LiDAR data become available and the full extent of the site watershed is 

captured, high-resolution DTM derived watersheds will replace the DEM watersheds derived from the 

National Elevation Dataset. 
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